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Copyright 
Copyright © 2003 - 2015 Intergraph® Corporation. All Rights Reserved. Intergraph is part of Hexagon. 

Including software, file formats, and audiovisual displays; may be used pursuant to applicable software license agreement; contains 
confidential and proprietary information of Intergraph and/or third parties which is protected by copyright law, trade secret law, and 
international treaty, and may not be provided or otherwise made available without proper authorization from Intergraph Corporation. 

U.S. Government Restricted Rights Legend 
Use, duplication, or disclosure by the government is subject to restrictions as set forth below. For civilian agencies: This was 
developed at private expense and is "restricted computer software" submitted with restricted rights in accordance with 
subparagraphs (a) through (d) of the Commercial Computer Software - Restricted Rights clause at 52.227-19 of the Federal 
Acquisition Regulations ("FAR") and its successors, and is unpublished and all rights are reserved under the copyright laws of the 
United States. For units of the Department of Defense ("DoD"): This is "commercial computer software" as defined at DFARS 
252.227-7014 and the rights of the Government are as specified at DFARS 227.7202-3. 

Unpublished - rights reserved under the copyright laws of the United States. 

Intergraph Corporation 
305 Intergraph Way 
Madison, AL 35758 

Documentation 
Documentation shall mean, whether in electronic or printed form, User's Guides, Installation Guides, Reference Guides, 
Administrator's Guides, Customization Guides, Programmer's Guides, Configuration Guides and Help Guides delivered with a 
particular software product.  

Other Documentation 
Other Documentation shall mean, whether in electronic or printed form and delivered with software or on Intergraph Smart Support, 
SharePoint, or box.net, any documentation related to work processes, workflows, and best practices that is provided by Intergraph 
as guidance for using a software product. 

Terms of Use 
a. Use of a software product and Documentation is subject to the End User License Agreement ("EULA") delivered with the 

software product unless the Licensee has a valid signed license for this software product with Intergraph Corporation. If the 
Licensee has a valid signed license for this software product with Intergraph Corporation, the valid signed license shall take 
precedence and govern the use of this software product and Documentation. Subject to the terms contained within the 
applicable license agreement, Intergraph Corporation gives Licensee permission to print a reasonable number of copies of the 
Documentation as defined in the applicable license agreement and delivered with the software product for Licensee's internal, 
non-commercial use. The Documentation may not be printed for resale or redistribution. 

b. For use of Documentation or Other Documentation where end user does not receive a EULA or does not have a valid license 
agreement with Intergraph, Intergraph grants the Licensee a non-exclusive license to use the Documentation or Other 
Documentation for Licensee’s internal non-commercial use. Intergraph Corporation gives Licensee permission to print a 
reasonable number of copies of Other Documentation for Licensee’s internal, non-commercial use.  The Other Documentation 
may not be printed for resale or redistribution. This license contained in this subsection b) may be terminated at any time and 
for any reason by Intergraph Corporation by giving written notice to Licensee. 

Disclaimer of Warranties 
Except for any express warranties as may be stated in the EULA or separate license or separate terms and conditions, Intergraph 
Corporation disclaims any and all express or implied warranties including, but not limited to the implied warranties of merchantability 
and fitness for a particular purpose and nothing stated in, or implied by, this document or its contents shall be considered or deemed 
a modification or amendment of such disclaimer. Intergraph believes the information in this publication is accurate as of its 
publication date. 

The information and the software discussed in this document are subject to change without notice and are subject to applicable 
technical product descriptions. Intergraph Corporation is not responsible for any error that may appear in this document. 

The software, Documentation and Other Documentation discussed in this document are furnished under a license and may be used 
or copied only in accordance with the terms of this license. THE USER OF THE SOFTWARE IS EXPECTED TO MAKE THE FINAL 
EVALUATION AS TO THE USEFULNESS OF THE SOFTWARE IN HIS OWN ENVIRONMENT.  

Intergraph is not responsible for the accuracy of delivered data including, but not limited to, catalog, reference and symbol data. 
Users should verify for themselves that the data is accurate and suitable for their project work.  
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Limitation of Damages 
IN NO EVENT WILL INTERGRAPH CORPORATION BE LIABLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL INCIDENTAL, 
SPECIAL, OR PUNITIVE DAMAGES, INCLUDING BUT NOT LIMITED TO, LOSS OF USE OR PRODUCTION, LOSS OF 
REVENUE OR PROFIT, LOSS OF DATA, OR CLAIMS OF THIRD PARTIES, EVEN IF INTERGRAPH CORPORATION HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  

UNDER NO CIRCUMSTANCES SHALL INTERGRAPH CORPORATION’S LIABILITY EXCEED THE AMOUNT THAT 
INTERGRAPH CORPORATION HAS BEEN PAID BY LICENSEE UNDER THIS AGREEMENT AT THE TIME THE CLAIM IS 
MADE. EXCEPT WHERE PROHIBITED BY APPLICABLE LAW, NO CLAIM, REGARDLESS OF FORM, ARISING OUT OF OR IN 
CONNECTION WITH THE SUBJECT MATTER OF THIS DOCUMENT MAY BE BROUGHT BY LICENSEE MORE THAN TWO (2) 
YEARS AFTER THE EVENT GIVING RISE TO THE CAUSE OF ACTION HAS OCCURRED.  

IF UNDER THE LAW RULED APPLICABLE ANY PART OF THIS SECTION IS INVALID, THEN INTERGRAPH LIMITS ITS 
LIABILITY TO THE MAXIMUM EXTENT ALLOWED BY SAID LAW. 

Export Controls 
Intergraph Corporation’s software products and any third-party Software Products obtained from Intergraph Corporation, its 
subsidiaries, or distributors (including any Documentation, Other Documentation or technical data related to these products) are 
subject to the export control laws and regulations of the United States. Diversion contrary to U.S. law is prohibited. These Software 
Products, and the direct product thereof, must not be exported or re-exported, directly or indirectly (including via remote access) 
under the following circumstances:  

a. To Cuba, Iran, North Korea, Sudan, or Syria, or any national of these countries.  
b. To any person or entity listed on any U.S. government denial list, including but not limited to, the U.S. Department of Commerce 

Denied Persons, Entities, and Unverified Lists, http://www.bis.doc.gov/complianceandenforcement/liststocheck.htm, the U.S. 
Department of Treasury Specially Designated Nationals List, http://www.treas.gov/offices/enforcement/ofac/, and the U.S. 
Department of State Debarred List, http://www.pmddtc.state.gov/compliance/debar.html.  

c. To any entity when Licensee knows, or has reason to know, the end use of the Software Product is related to the design, 
development, production, or use of missiles, chemical, biological, or nuclear weapons, or other un-safeguarded or sensitive 
nuclear uses.  

d. To any entity when Licensee knows, or has reason to know, that an illegal reshipment will take place.  

Any questions regarding export or re-export of these Software Products should be addressed to Intergraph Corporation’s Export 
Compliance Department, Huntsville, Alabama 35894, USA. 

Trademarks 
Intergraph, the Intergraph logo, CADWorx, and CAESAR II are trademarks or registered trademarks of Intergraph Corporation or its 
subsidiaries in the United States, and other countries. Microsoft, and Windows are registered trademarks of Microsoft Corporation. 
Oracle, JD Edwards, PeopleSoft, and Retek are registered trademarks of Oracle Corporation, and/or its affiliates. AutoCAD, 
ObjectARX, and RealDWG are trademarks of Autodesk. HOOPS is a trademark of Tech Soft 3D, L.L.C. Other brands, and product 
names are trademarks of their respective owners. 

CADWorx Design Review contains Autodesk® RealDWG by Autodesk, Inc., copyright © Autodesk, Inc. All rights reserved. 
Autodesk, Inc., 111 McInnis Parkway, San Rafael, California 94903 ("Autodesk") is a third-party beneficiary to this Agreement to the 
extent that the Software Product contains RealDWG, and to the extent that the provisions herein relate to Licensee’s use of the 
Software Product containing RealDWG. Such provisions are made expressly for the benefit of Autodesk, and are enforceable by 
Autodesk in addition to Intergraph. 
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This document provides command reference information and procedural instructions for 
CADWorx. 

For the latest support information for this product, comments or suggestions about this 
documentation, and documentation updates for supported software versions, please visit 
Intergraph Smart Support (https://smartsupport.intergraph.com). 

Intergraph® gives you permission to print as many copies of this document that you need for 
non-commercial use at your company. You cannot print this document for resale or redistribution 
outside your company. 

Conventions 
Before reviewing this guide, it is important to understand the terms and conventions used in the 
documentation. 

Use the information below to identify the convention and the type of information. 

Convention Type of Information 

[Product Folder] The CADWorx installation folder on your computer, for example, 
C:\CADWorx. Substitute your installation folder anywhere this 
notation is used. 

[AutoCAD Folder] The AutoCAD installation folder on your computer, for example, 
C:\AutoCAD 2000i. Substitute your installation folder anywhere 
this notation is used.  

[CD-DRIVE] The CD-ROM drive on your computer. Substitute your CD-ROM 
drive letter anywhere this notation is used.  

Command Line Items that need to be typed in or appear at the AutoCAD 
command line. 

User Responses User responses to command prompts. 

Commands CADWorx and AutoCAD commands. 

Options Command line options. 

CAPITALS AutoCAD system variables or keywords. 

Key + Key Key combinations for which you must press and hold down one 
key and then press another, for example, CTRL+P or ALT+F4. 

Preface for CADWorx Installation Guide 

https://smartsupport.intergraph.com/
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Technical Support 
For the latest information on CADWorx, visit Intergraph CADWorx and Analysis Solutions 
(http://www.coade.com/). 

For current on-line support information, including knowledge base, technical tips, and 
downloads, visit Intergraph Smart Support (https://smartsupport.intergraph.com). 

You can contact Intergraph CAS Technical Support or Sales:  

 ICAS Dealer Support (http://www.coade.com/Support/Dealers.shtml) or ICAS General 
Support (http://support.intergraph.com/Default.asp) 

 Technical Support E-mail: ppmcrm@Intergraph.com  

 Phone: 1-800-766-7701 (CADWorx Direct), 280-890-4566 (General)  

 Fax: 281-890-3301  

 Sales E-mail: sales.icas@intergraph.com  

In order to provide technical support, Intergraph CAS needs to know what version of CADWorx, 
AutoCAD, and Windows you are using. To determine this information, follow the steps outlined 
for the product you are using: 

CADWorx Product Steps 

Plant, P&ID, fieldPipe, or Steel  Run the CADWORXABOUT command. A dialog 
box opens and displays the version information. 

 Close the dialog box to send the required 
information to the AutoCAD command line. 

 Copy the information from the command line, and 
email it to Intergraph CAS. 

 Equipment or PV Fabricator  Run the EQUIPABOUT command. A dialog box 
opens and displays the version information. 

 Close the dialog box to send the required 
information to the AutoCAD command line. 

 Copy the information from the command line, and 
email it to Intergraph CAS. 

Internet Publisher Version information is displayed at the AutoCAD 
command line when you start the software. 

Datasheets Click Help > About to display a dialog box that contains 
the required information.  

In addition to the information above, the table below lists the additional files that are usually 
required to assist Intergraph CAS in resolving your technical issues: 

http://www.coade.com/
https://smartsupport.intergraph.com/
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CADWorx Product 

Additional Files Required by Intergraph CAS 
Support 

CADWorx Plant (Piping, Steel, HVAC) Email the AutoCAD model drawing (DWG) files.  

 If the model consists of several line numbers, 
indicate in the email which line numbers you are 
having issues with.  

 If the model consists of many drawing files with 
dependent reference drawings (XREFs), use the 
AutoCAD ETRANSMIT command to create a ZIP 
file of all the drawings used in the master model. 

CADWorx Plant (component data file 
creation) 

Email information about the part's dimension from the 
manufacturer's catalog. 

CADWorx Isogen Email the AutoCAD model drawing (DWG) files, any 
isometrics generated by Isogen, and the Isogen 
style files. 

 If the model consists of several line numbers, 
indicate in the email which line numbers you are 
having issues with.  

 The Isogen.FLS file located in the Isogen style 
folder lists all the files used (*.OPL, *.MLS, *.FLS, 
*.DDF, *.POS, *.ALT, *.DWG*.DXF, *.FDF, *.ATT). 
Email all files listed in the Isogen.FLS file, including 
the Isogen.FLS file. 

CADWorx Equipment Email the AutoCAD model drawing (DWG) files.  

CADWorx Equipment to PV Elite 
interface 

Email the AutoCAD model drawing (DWG) file and PV 
Elite input file (*.PVI). 

PV Fabricator Email the AutoCAD model drawing (DWG) files and PV 
Elite input file (*.PVI). 
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CADWorx P&ID or CADWorx IP Email the complete P&ID project, which includes 
Project.CFG, Database.TBL, Map.TBL, and all the 
DWG, and MDB files. Usually, all of these files are 
located in one folder.  

 If the project has many P&ID drawing files, indicate 
which P&ID drawings and components you are 
having issues with.  

 If you are experiencing database errors, include the 
file [Product 
Folder]\P&ID\System\Sql_Error_Log.TXT.  

 If you are emailing MDB files, use a compression 
utility such as WinZIP. Most email servers have 
restrictions on transmitting MDB attachments. 

CADWorx Steel Email the AutoCAD model drawing (DWG) files.   

 If the model consists of many components, indicate 
in the model which components or location you are 
having issues with. 

CADWorx Datasheets Email the datasheets MDB file and any datasheet file 
generated (XLS).   

 If emailing MDB / XLS files, use a compression 
utility such as WinZIP. Most email servers have 
restrictions on transmitting MDB / XLS attachments. 

CADWorx Plant to CAESAR II 
interface 

Email the AutoCAD model drawing (DWG) file and 
CAESAR II input file (*._A, *.C2).   

 Run the CADWorx GETALLSPECDATAFILES 
command to copy all specifications and data files 
used in the model into sub-folders under where the 
model drawing file is located.  

 Zip the contents of these folders and email the ZIP 
file to Intergraph CAS Support. 

 If the model consists of several line numbers, 
indicate in the email which line numbers you are 
having issues with. 
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CADWorx Design Review Email the AutoCAD model drawing (DWG) files.   

 If the model consists of several line numbers, 
indicate in the email which line numbers you are 
having issues with.  

 If the model consists of many drawing files with 
dependent reference drawings (XREFs), use the 
AutoCAD ETRANSMIT command to create a ZIP 
file of all drawings used in the master model. 

CADWorx Design Viewer Email the AutoCAD model drawing (DWG) files and the 
*.CDR file. 

 
 If you are attaching large or multiple files to your eCustomer log, use a compression utility 

such as WinZIP. 

 If you cannot attach your drawing files, then try to duplicate the issue in a new drawing with 
as few components as possible. If the issue can be duplicated in a new drawing, attach the 
duplicate drawing to Intergraph CAS. 

 For hardware lock issues, first verify that you have an Intergraph CAS hardware lock. 
CADWorx Plant Professional, CADWorx P&ID, CADWorx P&ID Professional, CADWorx 
Plant Ductile Iron, and CADWorx Plant Sanitary use the Intergraph CAS hardware lock for 
licensing. For more information, see Licensing in the CADWorx Installation Users Guide. 

What's New in CADWorx Installation 
Version 2016 (16.0) 

This document has been updated for this release. 

Items added and updated with CADWorx Installation 2016 
 CADWorx installs and uninstalls through the WiX installer. This simplified installer makes 

installing CADWorx faster and more efficient. For more information, see CADWorx 
Installation (on page 14). 

 You can install the Specification Editor with the WiX installer. For more information, see 
CADWorx Installation (on page 14). 
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S E C T I O N  1  

Intergraph® CADWorx® Plant Design Suite is an integrated, complete AutoCAD®-based 
software series for plant design that provides intelligent drawing and database connectivity, 
advanced levels of automation, and easy-to-use drafting tools. The comprehensive series of 
design tools includes structural steel, equipment, process and instrument diagrams, and design 
review, plus automatic isometrics and bills of material. 

CADWorx is quick and easy to set up and use, so you can start designing right away. The bi-
directional links between CADWorx and analysis programs for pipes and vessels enable 
designers and engineers to easily share information while keeping the drawings, models, and 
related information continuously synchronized as changes are made. And, the fast processing 
and highly refined user-interface features in CADWorx empower users to work efficiently 
together, even on large models.  

 

 

 

Welcome to CADWorx 
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S E C T I O N  2  

Software Compatibility 
CADWorx is compatible with the following AutoCAD versions: 

 AutoCAD 2016 (64 bit) 

 AutoCAD 2015 (64 bit) 

 AutoCAD 2014 (64 bit) 

 AutoCAD 2013 (64 bit) 

CADWorx is compatible with the following Autodesk vertical products (2016-2013): 

 AutoCAD Mechanical  

 AutoCAD Electrical  

 AutoCAD Architecture  

 AutoCAD MEP  

 AutoCAD Civil 3D  

 AutoCAD Map 3D 

CADWorx is NOT compatible with: 

 AutoCAD LT  

 Autodesk Inventor  

 Autodesk Revit  

The operating system compatibility is based on AutoCAD or the Autodesk vertical product used: 

 AutoCAD 2016: Windows 7, Windows 8 

 AutoCAD 2015: Windows 7, Windows 8 

 AutoCAD 2014: Windows 7, Windows 8 

 AutoCAD 2013: Windows 7, Windows 8 

 For the most up to date AutoCAD system requirements, check the Autodesk website. 
CADWorx fieldPipe does not support Windows 8. 
 

CADWorx Software Recommendations 



 CADWorx Software Recommendations 
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Requirements for fieldPipe 
To run all aspects of fieldPipe, the following requirements are needed for each palette: 

Installation Requirements 
The following items are needed to run the CADWorx fieldPipe - CloudWorx Interface palette 
in fieldPipe and must be installed in this order: 

 AutoCAD 2013 to AutoCAD 2016. 

 CADWorx fieldPipe supports Leica Cyclone 7.3 and above. To run the MS50 data, you must 
install Leica Cyclone 8.0 or later. The CADWorx installation DVD includes Leica Cyclone 
9.0.2.  

 CADWorx Plant 2016. 

The installation for fieldPipe is contained within the CADWorx installation. 

 CADWorx fieldPipe does not support Windows 8. 

 You must uninstall Leica CloudWorx prior to installing CADWorx fieldPipe, or 
CADWorx fieldPipe may cease to function.  

To prevent this issue do the following:  

1. Uninstall Leica CloudWorx. 

2. Reboot the computer.  

3. Reinstall CADWorx fieldPipe. 

Hardware Requirements (Optional) 
The following item is needed to run the CADWorx fieldPipe - TPS Interface palette in fieldPipe: 

 Leica TPS scanner with GEoCOM enabled 

 If the battery needs to be changed due to the power running low or running out, do 
not change the battery while running a command. If you change the battery and the total station 
is still connected to the software, make sure to turn the total station on before running a 
command. 
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S E C T I O N  3  

Install CADWorx on the system hard drive using the setup.exe installation file located on the 
CADWorx product CD. The installation process is relatively simple. As you go through the 
installation process, the software prompts you for required information.  

 If Autorun is enabled, the setup procedure starts when you insert the CD into the CD-
ROM drive. If the installation does not start automatically, double-click setup.exe 

Quick Start 
1. Run the SETUP.EXE. 

2. To start CADWorx, click the icon created during installation. 

3. Follow the dialogs will carry the user through the rest of the installation. 

4. First time run of the program will require certain startup parameters to be set. Most of the 
time, the defaults will be sufficient. 

CADWorx Installation 
The installation is similar to most other Windows installations. The following information is 
required: 

 What drive is used? 

 Which version of AutoCAD does CADWorx use? 

 Where will CADWorx be installed? 

 When installing a new version of CADWorx the AutoCAD profile settings are reset. When 
updating to a new version of CADWorx the AutoCAD profile settings are not reset.  

You must have administrative level rights to run the installer launch. You must also have 
elevated privileges to run the silent install instructions. 

To install CADWorx 

1. Insert the CD-ROM in the drive. 

2. Click Start. 

3. Select Run, or type the information below in the Search programs and files box. 

4. In the command line type <CD-DRIVE>:\CADWorxSetup.exe, Alternatively, click Browse 
to locate CADWorxSetup.exe on the CD ROM drive. 

5. Click Start Setup. 

6. Type the user name in the User Name box. 

7. Type the company name in the Company Name box. 

8. Select the software required for installation. 

Installation 



 Installation 
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9. Click each product name, except for Specification Editor, to expand each software 
selection, and then type the serial number provided by Intergraph.  

 P&ID Basic does not require a serial number. You can only install either P&ID 
Professional or P&ID Basic. 

10. Select the version of AutoCAD with which to run CADWorx.  

11. Specify the license type. Select ESL (Network, Red), ESL (Local, Green), or SmartPlant 
License Manager (SPLM) in accordance with your company purchase. If you select SPLM, 
the software prompts you with a dialog box asking if an SPLM-based license machine is set 
up. Click Yes. The default license is SPLM. 

12. Type the location drive and folder in Install Path, or click Browse to navigate to a folder. To 
use the default, click Next. 

 



 Installation 
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13. Select the I agree to the license agreement and conditions check box, and then click 
Install. 

14. If the User Account Control dialog box displays, click Yes. 

During the installation process, a progress bar displays along with the status of the 
installation process. 

 To view the readme, select the View Readme check box. The readme file displays 
after you click Finish. 

15. Click Finish. 

 If you need to modify the license type after installation, you can re-run the installation 
process. Then, select Repair/Modify, choose Add or Remove Features, select the 
License Type, and then click Update. During the installation process, a progress bar 
displays along with the status of the installation process. 

 

Install in Silent Mode 
To perform a silent installation of the software, type the required command instructions on the 
command line. 

 You must have administrative level rights to run the installer in silent mode. You 
must select Run as Administrator from the right-click menu. 

Example: 

[Root Directory]\CADWorxSetup.exe /install /silent /log 
"C:\SetupLog.log" USERNAME="IntergraphUser" COMPANYNAME="Intergraph" 
TARGETDIR="C:\CADWorx 2016" SLAACCEPT="YES" 
LICENSE_TYPE_CHOSEN="ESLGreen" ACAD_VERTICAL_VERSION="ACAD|2016" 
ADDLOCAL="CORE_FEATURE,PLANT_FEATURE,PIDPRO_FEATURE" 
PLANT_SERIALNUM="00000000000000" PIDPRO_SERIALNUM="00000000000000" 

Ensure you are in the directory of the CADWorxSetup.exe file. 

All values must be typed with quotations. 

Command Line Option Description Available Options 

/install Runs the installer.  \install 

/silent Specifies that you are running 
a silent installation. With the 
silent installation, the installer 
dialog boxes do not display, 
and the installation process 
runs in the background. 

\silent 

USERNAME Specifies your user name. Any user name in your network.  

Ex: USERNAME="IntergraphUser" 

COMPANYNAME Specifies your company name. Any company name in your network. 

Ex: COMPANYNAME="Intergraph" 



 Installation 
 

 

CADWorx Installation Guide 17 
 

TARGETDIR Specifies the location folder for 
the CADWorx install. 

Any available location on your machine. 
Ex. "C:\CADWorx 2016" 

/log Enables you to view details of 
the silent install. 

\log 

SLAACCEPT  Specifies that you accept or do 
not accept the license 
agreement. If you type "NO" 
the installation process does 
not complete. You must accept 
the license agreement for the 
installation to complete. 

 "YES"  

 "NO" 

LICENSE_TYPE_CHOSEN Specifies the license type in 
accordance with your company 
purchase. 

 "SPLM"  

 "ESLRed Local" 

 "ESLRed Remote" 

 "ESLGreen" 

ACAD_VERTICAL_VERSION Specifies the version type and 
year of the AutoCAD you are 
using. For example 
"ACAD|2016" specifies that 
you are using AutoCAD 2016. 
For the latest AutoCAD 
compatibility, see CADWorx 
Software Recommendations 
(on page 12). 

 "Civil3D" 

 "ACAD"  

 "Map"  

 "ADT"  

 "ACADM"  

 "MEP"  

 "ACADE"  

 "2013" 

 "2014"  

 "2015" 

 "2016" 

ADDLOCAL Specifies the CADWorx 
products to install. You can 
only install fieldPipe when you 
install PLANT_FEATURE. You 
can either install 
PIDPRO_FEATURE or 
PIDBASIC_FEATURE. 

 Separate each 
option only with a comma. Do 
not place spaces before or 
after a feature option. 

 "PLANT_FEATURE"  

 "PIDPRO_FEATURE"  

 "FIELDPIPE_FEATURE"  

 "SPECEDITOR_FEATURE"  

 "PIDBASIC_FEATURE" 

 "CORE_FEATURE" 

.  
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RUN_REDISTRIBUTE Runs the redistributable 
executables 
(VC2008Redistribute.exe, 
VC2010Redistribute, and 
VC2013Redistribute). The 
default setting is "YES". 

 "YES"  

 "NO" 

PIDPRO_SERIALNUM Specifies the P&ID Profession 
serial number provided by 
Intergraph. You only need to 
type this option if you are 
installing PIDPRO_FEATURE. 

 See Example above. 

PLANT_SERIALNUM Specifies the Plant 
Professional serial number 
provided by Intergraph. You 
only need to type this option if 
you are installing 
PLANT_FEATURE. 

 See Example above. 

FIELDPIPE_SERIALNUM Specifies the fieldPipe serial 
number provided by 
Intergraph. You only need to 
type this option if you are 
installing 
FIELDPIPE_FEATURE. 

 See Example above. 

 

Repair in Silent Mode 
To perform a repair of the installation, you need to run the command prompt as an 
Administrator, and then type the pertinent command instructions on the command line. 

Example: 

[Root Directory]\CADWorxSetup.exe /repair /silent /log 
"C:\SetupLog.log"  

Ensure you are in the directory of the CADWorxSetup.exe file. 

/repair 

Runs the repair of the installer.  

/silent 

Specifies that you are running a silent repair to the installation. With the silent repair to the 
installation, the installer dialog boxes do not display, and the repair runs in the background. 

 The repair functionality only repairs products or features that were already installed. 
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Setup Profile 
Enables you to start CADWorx in different versions of AutoCAD. You need to run the 
Setup_Profile utility with Administrator privileges. 

Select CADWorx 

Enables you to select the version and product you want to run. 

 CADWorx Version 

Specifics the version of CADWorx you want to run. 

 CADWorx Product Location 

Specifies the location of the CADWorx installation for the product you select from the 
Product List. 

 Product List 

Specifies the product you want to run, such as Plant or P&ID. 

Select AutoCAD 

Enables you to select the version of AutoCAD you want to run for the CADWorx version. 

 AutoCAD Product Location 

Specifies the location of the AutoCAD version selected in the AutoCAD Version List. 

 AutoCAD Version List 

Specifics the version of AutoCAD you want to run. Lists only available and supported 
versions of AutoCAD. 

Launch CADWorx in a different version of AutoCAD 
1. In your [Product Folder], right-click CADWorx_Setup_Profile.exe, and then select Run as 

administrator. 

2. Click CADWorx Version, and then select a version from the list. 

The installed CADWorx products display in the Product List. 

3. Select one or more products from the Product List. 

 When you select a CADWorx product, the Current AutoCAD for that product 
displays below the Product List. 

4. Select the AutoCAD version you want to run from the AutoCAD Version List.  

 The software only lists supported versions of AutoCAD. 

5. Click OK. 

The CADWorx [Product] [Version] Profile Created message box displays. 

6. Click Yes. 

The CADWorx product launches in the selected version of AutoCAD. 
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Software Installation on Network Drive 
 Administrator rights are required on the computer to install the software. After installation 

is complete, administrator rights can be revoked. Administrator rights are not required to run 
CADWorx. 

Installing the software on a network drive is no different than installing it on a local hard drive--
specify the target installation drive and folder, and the software is installed accordingly. Some 
networks protect installation folders from subsequent modification. As such, CADWorx requires 
setting the access rights to the installation folder to write, read and modify in specific folders.  

Because CADWorx uses data files specific to the installation that you may need to modify, these 
files cannot be located in the protected installation folder. Instead, these data files are located in 
a sub-folded named [Product Folder]\Plant\System and [Product Folder]\Plant\Support. Give 
users all access rights to both folders. 

 Although the actual name of the software installation folder can be user-specified, the 
\System and \Support folder names are fixed and created automatically during the installation 
process. Renaming either of these sub-folders causes the software to generate errors and fail. 
Renaming the sub-folders causes the software to generate errors and fail.  

If users are allowed to modify the specifications and/or component data files, these default 
folders must also allow full access. Specification files are found in the [Product Folder]\Spec 
folder. Data files are contained in the .prj file but are found in \Steel_I, and \Steel_M folders for 
steel. After the software is installed, you can use the configuration facilities within the Pipe and 
Steel Setup functions to move these folders to a user-specified location. For more information, 
see Setup in the CADWorx Plant User's Guide. 

When the software is installed on a network drive, each client computer must contain the 
command line directives in the icon to properly locate and run the software. The easiest way to 
create the icon is to run the CADWorx Plant Setup Profile on the client computer.  

CADWorx can be run on a network or on stand-alone computers. Three different network 
installation configurations are possible. 

1. Software is installed on a network drive. A green local hardware lock is attached to all client 
computers. 

2. Software is installed on a network drive or on individual client computers. A red lock is 
attached on a network system, and subsequently accessed by multiple users.  

3. Software is installed on a network drive. Local hardware locks and a network hardware locks 
are used. 
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CADWorx Design Review Installation 
CADWorx Design Review is included with your CADWorx package but must be installed 
separately. The installation process is detailed in the steps below: 

1. Insert the CD ROM in the drive. 

2. Click Start. 

3. Select Run, or type the information below in the Search programs and files box. 

4. In the command line type <CD-DRIVE>:\cdr, (or click Browse to locate cdr on the CD ROM 
drive). 

5. Click OK to start the installation. 

 If the location for setup is already defined but access is denied that location, then 
CADWorx Design Review asks you to specify a new location. If this happens select the new 
location, and click OK. 

6. In CADWorx Design Review Setup, click Next. 

7. Click I accept the terms in the license agreement, and click Next. 

8. Check the destination folder to make sure it is correct, and click Next. 

9. In Ready to Install, click Install. 

10. In User Account Control, click Yes. 

11. Click Finish. 
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S E C T I O N  4  

CADWorx supports three types of licensing: 

 Local External Software Lock (ESL) 

Hardware-based licensing using a green USB dongle. A local ESL can be moved 
between computers (such as between desktops and laptops). 

 Network External Software Lock (ESL) 

Hardware-based licensing using a red USB dongle. A network ESL is installed on a 
computer that is network accessible from the computer, or multiple computers, running 
CADWorx. 

 License Manager 

Software-based licensing using SmartPlant License Manager (SPLM). For more 
information, see SmartPlant License Manager Installation (on page 26). Refer to the 
SmartPlant License Manager documentation for complete installation and configuration 
instructions. 

External Software Lock (ESL) Keys 
The External Software Lock (ESL) is the security protection method used by Intergraph CAS, 
Inc. The software cannot execute unless an appropriate ESL (green or red USB key) is 
connected locally to the computer, or to another computer in the network (red USB key). 

The ESL contains the CADWorx licensing data, and other client-specific information. This 
information includes the client company name and user ID number. Additional data may be 
stored on the ESL depending on the specific program and the specific client. 

There are two different ESL types, local and network. Both types of ESLs are intended to be 
attached to the USB ports of the applicable computers. The appropriate ESL(s) are shipped with 
your product according to the licensing type purchase. 

 Local ESLs provide the maximum flexibility in using the software in that they can be moved 
between computers (for example, between desktops and laptops). 

 Network ESLs must be attached to a computer on the network, either a computer or the 
server. In order for the network to respond to software requests for the ESL, the NetHASP 
License Manager utility must also be running on the computer where the network ESL is 
attached. 

The HASP drivers for ESL usage can be found in the sub-directory, ASSIDRV, beneath the 
analysis products program directory. However, for CADWorx the HASP drivers for ESL usage 
can be found in the sub-directory, Utilities. The documentation files in this sub-directory contain 
instructions for a variety of networks and operating systems. Note that there are periodic 
updates to these ESL drivers and they can be downloaded from the Intergraph Smart Support 
(https://smartsupport.intergraph.com) website. 

 Do not connect two locks to the same computer. The software finds the first lock and 
returns its code. For example, you have a lock for CAESAR II and CADWorx and plug both into 
the same computer. You start CAESAR II, but the software might find the CADWorx lock first 

Licensing 

https://smartsupport.intergraph.com/
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and return an error. If the same computer is going to run more than one Intergraph CAS, Inc. 
product, then contact Intergraph CAS by sending an email to 
icaslicenserequests@intergraph.com to request that both products be licensed from the same 
lock. 

ESL Installation 
The following topics explain how to install the different hardware locks supported by CADWorx. 
 

What do you want to do? 
 Install a local lock (on page 23) 

 Install a network lock (on page 23) 
 

Install a local lock 
1. Open Windows Explorer. 

2. If you are installing CAESAR II, PV Elite, or TANK, navigate to c:\Program Files\Intergraph 
CAS\Product\Assidrv and double-click HASPUserSetup.exe. 

-OR- 

If you are installing CADWorx, navigate to C:\CADWorx Version\Utilities and double-click 
HaspHLDriverSetup.exe 

3. Follow the on-screen instructions to install the driver. 

Install a network lock 
The following list details general information about red network ESLs. 

 The red network ESL should be set up by a Network Administrator or someone familiar with 
Windows-based networks. If you are not familiar with concepts such as network protocols, 
broadcast, IP addresses, TCP, UDP, and Windows Services, please do not attempt to setup 
the red network ESL. 

 The red network ESL does not have to be attached to the network server. We recommend 
attaching the red network ESL to a computer that is always up and running, can be re-
booted without impact to users, and is not the primary computer for any user on the network. 

 If you install an Intergraph CAS product on a network drive for multiple users to access, 
assign read/write privileges for all users to the [Product Folder]\System folder. Intergraph 
CAS applications write temporary files to the [Product Folder]\System folder that pertains to 
the installation. The [Product Folder]\System folder also needs to have read/write privileges 
for all users. 

 If you are using other network protocols, such as NetBIOS or IPX, check the SafeNet web 
site for instructions. The only protocol tested with Intergraph CAS products is TCP/IP. 

 The information provided in the analysis products Help file is a supplement to the NetHasp 
User's Guide, which is delivered as a PDF(_NETHASP.pdf) in Assidrv folder. CADWorx 
delivers this _NETHASP.pdf in the Utilities folder. Review the PDF file for any issues not 
addressed in the Help file. 
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Notes on Network ESLs 
A network ESL has advantages and disadvantages. One big advantage is that many client 
computers can access the software from a single server. Additional points for consideration are 
listed below. 

 Depending on the number of licenses allowed by the network ESL, some users may receive 
error messages when attempting to access the software. For example, if the ESL has been 
configured to allow four simultaneous users, an error message stating that no licenses are 
available when the fifth user attempts to access the software. Consequently, the fifth user is 
not able to access the software until one of the first four users exits the software and 
releases a license. 

 Because of the communication procedures between the client computer and the file server, 
memory access to the network ESL is much slower than to a local ESL. This access time 
delay only occurs when the software is first started after installation.  

 Because there is no network specific version of the software, the software looks first for a 
local ESL, and then for a network ESL. This allows both a network ESL and several local 
ESLs to be used on the same system. This transparent ESL access procedure allows a 
single version of the software to be used on the network and on remote computers. 

 We recommend that only 70 to 80 percent of the required licenses be assigned to a network 
ESL, with the remaining 20 to 30 percent assigned to local ESLs. This enables the local ESL 
to be moved between computers. If all of the licenses are on the network ESL, a user must 
be logged into the network to access the software. As such, a few local ESLs provide much 
greater operating flexibility. 

NetHASP License Manager / NETHASP.INI Instructions 
 You must have Administrator privileges to perform the following procedure.  

1. Attach the red network hardware lock to the parallel port or USB port of the computer. 

2. On the computer where the hardware lock is attached, navigate to the analysis products' 
Assidrv folder, and then double-click Lmsetup.exe. For CADWorx, navigate to the [Product 
Folder]\Utilities to access LMsetup.exe. Follow the on-screen instructions to install the 
NetHASP License Manager as a service. 

3. The NetHasp License Manager starts automatically each time you re-boot the computer. 
This occurs because the NetHasp License Manager is set up as a start up service inside 
Windows 7/8. To verify that the service is running, click Start > Control Manager > 
Administrative Services, and then double-click Services. In the Services dialog box, 
locate HASP Loader in the Name list. The HASP Loader Service starts even if no one logs 
into the computer. 

4. Determine what protocols the NetHasp License Manager is listening to. The NetHasp 
License Manager displays a message similar to those list below: 

Server is listening to IPX : Loaded 

Server is listening to TCP/IP : Loaded 

Server is listening to NetBIOS : Loaded 

 Loaded means that this protocol is active on the computer.  

5. Open the Activity Log menu. This displays the activity log that confirms which protocols are 
loaded. Do not be alarmed if the activity log reports that the NHSRV.ini file is not found. 
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6. Use the box in the top-left corner of the activity log to display only the information specific to 
each protocol. Open the activity log for the protocol you want to use, and verify that it 
contains no error messages. 

7. For TCP/IP protocol, the activity log should report something similar to the following: 

Server IP address: 111.111.111.111 

Server Host Name: PDC_NT01 

8. To speed up response time to the network key, use the Remove menu to unload any 
protocols that you are not planning to use with the NetHasp License Manager.  

Modify NetHASP.ini for TCP/IP Protocol 
 If you still cannot access the network ESL you need to configure this NetHASP.ini 

file. You must know the IP address of the computer where the red network hardware lock is 
attached. All lines with a semi-colon at the start are considered not used.   

1. Modify the NetHASP.ini file, located in the analysis products' Assidrv folder and in 
CADWorx's Utilities folder under [NH_COMMON], as follows:  

a. NH_TCPIP = Enabled 

AND under [NH_TCPIP] 

b. NH_SERVER_ADDR = 111.111.111.111 

c. NH_USE_BROADCAST = Disabled 

 You may also have to modify other entries in the [NH_TCPIP] section depending on 
your network setup. The most common entry to modify is NH_TCPIP_METHOD. 

2. Copy the NetHASP.ini file to the AutoCAD folder. 

Example: C:\Program Files\AutoCAD 

Example: C:\Program Files\Autodesk\AutoCAD 

3. For CADWorx Design Review, copy the NetHASP.ini file to the [Product Folder]\Intergraph 
CAS\CADWorx Design Review folder. 

4. Start CADWorx Plant. 

Troubleshooting Network Locks 
1. Verify that the NetHasp License Manager is running on the computer where the red network 

ESL is attached. 

2. Verify the protocols that NetHasp License Manager is broadcasting. Make sure that these 
protocols are installed on the client computers. 

3. Install and run the Monitor Utility. You can find the NetHASPMonitorSetup.exe located in the 
analysis products' Assidrv folder. For CADWorx, you can find the 
NetHASPMonitorSetup.exe in the [Product Folder]\Utilities. If NetHASP Monitor cannot find 
the red network ESL, then CADWorx cannot find the red network ESL. 
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SmartPlant License Manager Installation 
Before beginning the product installation, refer to the delivered SmartPlant License Manager 
readme file for the latest product installation updates. The readme file is delivered in the top 
level product folder of the product media. Be sure you have the latest version of the SmartPlant 
License Manager software before beginning the installation. If you do not have the latest version 
of the software, you can download it from Intergraph Smart Support Online 
(https://smartsupport.intergraph.com). 

 SmartPlant License Manager 2010 (v11) can be upgraded to SmartPlant License 
Manager 2012 (v12). Any existing license key will be invalidated after the upgrade to SmartPlant 
License Manager 2012 (v12). You will need to generate a new machine ID and request a new 
key.  

Quick Installation Workflow 
Use this workflow for all products that require SmartPlant License Manager licensing. The 
System Administrator completes or gives guidance about most of these steps. Administrator 
rights are required to install and set up SmartPlant License Manager. If you need more 
information, follow the detailed procedures in the other sections. For more information, refer to 
Functions of SmartPlant License Manager: License Machine and Appendix G: Error Messages 
and Troubleshooting. 

 Please refer to the delivered SmartPlant License Manager Readme for all the latest 
product installation updates. 

1. Designate a computer as the SmartPlant License Manager license machine. This computer 
must be on the network and have a name with no spaces and a static IP address.  

2. Install SmartPlant License Manager using the License Machine option on the license 
machine and generate a machine ID.  

3. Request a license key from the Intergraph Order Desk or generate a license key using 
eLicense (https://ppmapps.intergraph.com/elicensev3).  

4. Click Start > Programs > Intergraph SmartPlant License Manager > SmartPlant 
License Manager.  

5. Click Install and Remove and Install License Key commands.  

6. Enter the license key you received. If the license key installs correctly, the SmartPlant 
License Manager software automatically closes. 

7. Next, install SmartPlant License Manager using the License Client option on each client 
computer.  

8. Click Start > Programs > Intergraph SmartPlant License Manager > SmartPlant 
License Manager.  

9. Click Configure and Test and Select License Machine for Client.  

10. Enter the SmartPlant License Manager license machine name. Exit SmartPlant License 
Manager.  

11. Install the software that requires licensing, for example, SmartPlant Review, PDS, or 
SmartPlant P&ID. Use that product's installation and configuration guides to install each 
product.  

https://smartsupport.intergraph.com/
https://ppmapps.intergraph.com/elicensev3
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12. Use the Test Seat Reservation and Test Seat Release commands to ensure that 
communication is working between the license machine and the client. Successful 
messages show appropriate communication.  

13. Click Test Seat Reservation. Select the license machine name and Batch or Interactive 
mode. Note the seat number in the SmartPlant License Manager Information dialog box 
to enter.  

14. Click Test Seat Release and enter the seat designated in the SmartPlant License 
Manager Information dialog box.   

15. Start the software product that requires SmartPlant License Manager licensing.  

16. For information about firewalls, please refer to Appendix E: Microsoft Windows Firewall and 
SmartPlant License Manager. 

Frequently Asked Questions (FAQ) 
For the most current questions and answers about SmartPlant License Manager, see Intergraph 
Smart Support Online (https://smartsupport.intergraph.com). Type your question in the Search 
Answers page, and click Search. 

Purchasing Licenses FAQ 
Q: Do I have to request a software upgrade from my local office before requesting a 
license? 

A: No, you can request licenses without upgrading the software. If you are upgrading 
software, you must request the upgrade before you request licenses. A license request does 
not include a software upgrade and a software upgrade does not include a license request. 

Q: Is there a form to use for requesting licenses? 

A: Yes, there is a PDF form and the same content in an Excel spreadsheet. All products 
except INtools 6.0 and earlier use the same form, which is found on the following web page: 
http://www.intergraph.com/ppm/products.aspx. Click SPLM Request Form on the right side 
of the page. This form is also located on Intergraph Smart Support Online. 

INtools 6.0 and earlier uses its own form, found on the SmartPlant Instrumentation > 
Additional Information web page. 

Q: How do I purchase licenses? 

A: Contact your local sales account manager to request an upgrade of the lease profile to 
include purchase licenses. See https://ppmapps.intergraph.com/elicense. 

See Also 
General Topics FAQ (on page 27) 

General Topics FAQ 
Q: What product licenses are managed with SmartPlant License Manager 2012? 

A: SmartPlant License Manager supports the following products and license types: 

 CAESAR II 
 CADWorx 
 FrameWorks® Plus 
 ISOGEN™ (Batch ISOGEN and Interactive ISOGEN) 

https://smartsupport.intergraph.com/
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 PDS®: PDS 3D, PDS 2D, PDS IDM, PDS 2D PID 
 PV Elite 
 PV Fabricator 
 SDNF Import 
 Smart 3D to PDMS Exporter 
 SmartMarine® 3D 
 SmartMarine 3D Hull 
 SmartMarine 3D Layout 
 SmartMarine 3D Outfitting 
 SmartMarine 3D Tribon 
 SmartPlant Construction 
 SmartPlant® Electrical Basic (formally SmartPlant Electrical) 
 SmartPlant Electrical Detailed Engineering (formally sigraph.CAE) 
 SmartPlant Instrumentation (formerly INtools®) 
 SmartPlant Isometrics (formerly I-Sketch) 
 SmartPlant Materials 
 SmartPlant Materials Material Life Cycle Library 
 SmartPlant Materials Engineering and Procurement Integration Module 
 SmartPlant Materials Material Supply Chain Management Module 
 SmartPlant Materials Site Management Module 
 SmartPlant Materials Integrator Module 
 SmartPlant Materials Supplier Module 
 SmartPlant P&ID 
 SmartPlant P&ID Design Validation Tool 
 SmartPlant P&ID Engineering 
 SmartPlant Plant Engineering Solution Bundle 
 SmartPlant 3D 
 SmartPlant 3D Bundle (Support bundle licensing in SmartPlant 3D, SmartMarine 3D, 

and SmartPlant 3D Materials Handling Edition) 
 SmartPlant 3D Import commands 
 SmartPlant 3D Materials Handling Edition 
 SmartPlant Layout 
 SmartPlant Reference Data 
 SmartPlant Review 
 SmartPlant Review Publisher 
 SmartPlant Spoolgen® (formerly SPOOLGEN) 
 SmartSketch® 
 SmartSketch Drawing Editor 
 SupportModeler™ for PDS 
 SupportManager™ for PDS 
 TANK 

Q: What new features were added in SmartPlant License Manager 2012? 

A: We added a new counted type seat for the license key. We also added new options in 
the SmartPlant License Manager interface and improved some existing functions. 
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Q: Where can I find SmartPlant License Manager and other products to download?  

A: SmartPlant License Manager is available from Intergraph Smart Support Online 
(https://smartsupport.intergraph.com). 

Select View Downloads > SmartPlant License Manager. 

You do not need a serial number to install SmartPlant License Manager.  

Q: What do I need to do to receive a License Key? 

A: You need to generate a Machine ID from your license machine and submit it to 
Intergraph to request a license key. After installing SPLM 2012 v12, you can find the 
Generate Machine ID utility on your Start menu (Programs > Intergraph SmartPlant 
License Manager). 

To prevent a loss in production, you can pre-request a new SPLM 2012 license key before 
upgrading your SPLM 2010 or previous version to SPLM 2012. You can download the utility 
(splmGenMachineID.exe) from Intergraph Smart Support Online 
(https://smartsupport.intergraph.com). For more information, please check our document 
“Important Upgrade Info for SPLM 2012.pdf” on the eLicense and Smart Support sites (View 
Downloads > SmartPlant License Manager > Technical Notes and Whitepapers > 
SmartPlant License Manager 2012 (v12)). 

Q: What is a license machine? 

A: The license machine is the computer where the license key is loaded; it can be a 
standard computer or a server. The license key tells the license machine how many licenses 
it can issue. Clients of a license machine are computers where SmartPlant License Manager 
is installed and pointing to the license machine. The computer where you start the software 
(for example, PDS or SmartPlant P&ID) asks the license machine for a license. If a license 
is available, the license machine provides it. If all licenses are in use, the client is not 
granted a license.  

Q: What is the Machine ID? 

A: The Machine ID is a collection of hardware and software identifiers that together allow a 
machine to be uniquely identified. The Machine ID is used to manage licenses. The 
information is used to generate the license key and is not useful to other software programs. 

Q: Do I need to have SmartPlant License Manager installed in order to generate the 
Machine ID?  

A: No. The utility used to generate the machine identifier is included in the SmartPlant 
License Manager installation but can be downloaded separately without installing 
SmartPlant License Manager. The utility is used to generate the Machine ID, which is used 
to produce keys for the license machine. SmartPlant License Manager and the new licenses 
may be installed at the same time, minimizing disruption and down time.  

Q: Will providing the Machine ID make my computer less secure? 

A: No. The Machine ID allows the license manager to uniquely identify your computer from 
a collection of hardware and software identifiers without explicitly publishing your computer's 
TCP/IP address. Because the computer identifier cannot be used like a TCP/IP address, it is 
actually more secure than publishing your computer's TCP/IP address. 

Q: Is my existing key still running if I regenerate the Machine ID? 

A: Yes, but you will not be able to reinstall the old key. You will need to request a new key 
for the new machine identifier. 

https://smartsupport.intergraph.com/
https://smartsupport.intergraph.com/
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Q: I currently have SPLM v11 installed. Can I install SPLM v12 on top of this version? 
What will happen with my current license key?  

A: Yes, you can over-install SPLM 2012 v12 on your current SPLM 2010 v11 license 
machine or client, but you will need to generate a new machine ID, and request and install a 
new key after you upgrade to SPLM 2012 on your license machine.  

Q: Can I pre-request a SPLM v12 license key to prevent production down time? I currently 
have SPLM v11 installed. 

A: Yes, you can pre-request a SPLM v11 license key prior to upgrading to SPLM v12 on 
your license machine. You need to download the Generate Machine ID executable for 
SPLM 2012 (splmGenMachineID.exe) first to get a v12 machine ID and then request a 
SPLM v12 license key. 

Detailed instructions can be found in “Important Upgrade Info for SPLM 2012.pdf." Be sure 
to read this document first before upgrading your license machine. 

Both the upgrade instructions and the Generate Machine ID executable for SPLM 2012 
(splmGenMachineID.exe) can be downloaded from Intergraph Smart Support Online 
(https://smartsupport.intergraph.com) or from eLicense 
(https://ppmapps.intergraph.com/elicensev3).  

Q: How can I tell what version of SPLM was used in the Machine ID or license key file? 

A: Please check the starting number or letter in your Machine ID or license key. See the 
table below. 

Version Machine ID starts with License key starts with 

2012 (12.00.82.00) M K 

2012 (12.00.16.00) A 4 

2012 (12.00.05.00) 5 3 

2010 (v11) 6 2 

2008 (v10) 7 1 

Q: How can I find the version of SmartPlant License Manager that I have installed? 

A: You can find that information in the readme.txt or readme.html located in the product 
directory (by default, C:\win32app\INGR\SPLM), or you can select Help > About 
SmartPlant License Manager located in the top right corner of the SmartPlant License 
Manager user interface.  

Q: What happens if I install the new license key prior to expiration of the old license key?  

A: The new license will overwrite the existing key independent of the expiration date. 

Q: Do I have to have one license machine for each LAN?  

A: No, your configuration is entirely up to you. A persistent network connection is required if 
you want to connect to a license machine that belongs to a different LAN. 

https://smartsupport.intergraph.com/
https://ppmapps.intergraph.com/elicensev3
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Q: Can I divide the licenses for one LAN into several license machines for the purpose of 
managing project access, for example, or as coverage in the event that my license 
machine goes down?  

A: Yes, you can divide the licenses. 

Q: How do I remove SmartPlant License Manager?  

A: Select Start > Control Panel > Programs and Features > Uninstall SPLM from the list  

 If you need to set up your license machine again after you remove SPLM, you will 
need to re-install SPLM, generate a new Machine ID, and request a new key.  

Q: Can I set up the SmartPlant License Manager license machine in a Virtual Machine? 

A: Yes, you can set up the SmartPlant License Manager license machine in a virtual 
machine. However, only limited testing had been done and there is a high potential of 
failure. We do not recommend setting up a license machine in a virtual environment. We can 
only provide very limited support for SPLM licensing machine running in any virtual 
configurations.  

 If you are experiencing problems with your SPLM machine configured in a virtual 
environment you will ask you to configure a non virtualized environment. Only after the 
problem is known to be reproducible in a non virtualized environment will Intergraph react to 
the problem. To troubleshoot your virtual configuration problems may require a consulting 
services agreement and might not be covered under your regular maintenance agreement.  

Q: Is the SmartPlant License Manager User’s Guide delivered with the software 
products?  

A: Yes. The SmartPlant License Manager Installation and User’s Guide is included with all 
products that require SmartPlant License Manager. The document is also available with the 
product documentation on Intergraph Smart Support Online 
(https://smartsupport.intergraph.com).  

This document explains the new features, client and license machine installations and 
functions, upgrade instructions, license control, error messages, and troubleshooting.  

Q: What is license stacking?  

A: License stacking gives an administrator the ability to input two license keys (this month's 
and next month's), each with its own quantity of licenses for each of the next two months. 
This gives system administrators much more freedom and helps ensure there is no down 
time.  

Q: Do I need to remove the existing key in order to input two license keys for two 
months?  

A: No. You schedule next month’s licenses this month. Get a new key, create the bat file, 
and submit it to install. Once the installation date/time has passed, the new key will be the 
one installed. 

pdlice -a keyvaluehere >>outputfilehere 

Submit the bat file to either the AT services or a batch queue to run at a specified time.  

https://smartsupport.intergraph.com/
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Q: How are the number of licenses for a given license machine determined?  

A: The number of licenses covered by a license key equals the total number of licenses that 
you have purchased or are leasing for each LAN ID listed for that license server. Intergraph 
records determine the correct number of licenses for the key. 

To change the number of licenses for a LAN, use the License Key Request Form found on 
the following web page:  

http://www.intergraph.com/ppm/products.aspx 

Sending this form does not change your number of licenses; it notifies Intergraph that you 
want to do so. A valid purchase order is required to increase the number of licenses for your 
LAN.  

Q: How do I check the number of licenses in a license key?  

A: On your licensing machine, click Show Key Status on the Display Options dialog box 
to show the status of your keys.  

Q: How can I tell who is using a license?  

A: Click Display Status of Reserved License on the Display Options dialog box. 

Q: Does the installation date have to be precise?  

A: The key can be installed any time during the 72-hour period that begins with the 
installation date you provide. For example, if you request 01-July-2008 as the installation 
date, the key can be installed on 01-July, 02-July, or 03-July.  

Q: Can I make an educated guess at my installation date? 

A: Yes. Intergraph will provide a key within 48 hours of receipt of your request (via mail or 
phone). Please ensure that the date you request is the actual date that you will install the 
key, making sure that all necessary software is available and loaded before that date. We 
request that you notify us as early as possible.  

Q: What happens if my licensing machine goes down?  

A: You will be unable to check out licenses from this machine until it is back in use. 
Processes that already have licenses checked out are not affected by the fact that the 
license computer is unavailable. 

It is possible in critical situations to request emergency licenses from Intergraph. They are 
installed on the client computer rather than a licensing machine. Contact Intergraph Support 
at 1-800-766-7701 or your local Intergraph office for more information. 

Q: What happens if the license machine is rebooted in the middle of my design session?  

A: Nothing. Licensing does not depend on maintaining a continuous communication link to 
the license machine.  

Q: What happens if my local computer goes down after I've obtained a license?  

A: If the scavenger cannot contact the client computer during scavenging, the license is 
marked for a 16-hour hold before it is released. The scavenger periodically advances this 
16-hour timer for each license. It is important to schedule the scavenger to run regularly, at 
least every hour or two. If the client is in contact sooner, the hold is voided and normal 
scavenging takes over.  
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Q: I am running out of licenses earlier than I believe I should be. How can I troubleshoot 
to understand what is happening?  

A: The Admin user can run Scavenge for Keys on the Scavenge Options dialog box or 
you can type pdlice -n in a Command Prompt window on the license machine.  

If you think that client nodes are improperly holding onto licenses, examine the results of the 
pdlice -M command. This shows you which client nodes have licenses checked out. If a 
client computer has no plant design-related activity and it is still holding licenses, rebooting 
that client and then scavenging from the licensing machine may free some licenses. 

If possible, find out what was processing when the job stopped. This information can help 
you and/or Intergraph determine the underlying cause of the termination. Save the output of 
any scavenging process that returns a license. This information will provide the reasons why 
the license was returned. The output of the scavenger includes the following information: 
nodename, product tag, batch mode (Yes/No), process ID, and checkout time.  

Q: Can SmartPlant License Manager be installed on a laptop computer? 

A: Yes, SmartPlant License Manager can be installed on a laptop and a laptop can be used 
as a SmartPlant License Manager client or licensing machine. 

1. Download the latest SmartPlant License Manager software from Intergraph Smart 
Support Online and install the software. 

2. Prepare the laptop for machine ID generation: Disable all the network connections 
except the loopback adapter before generating the Machine ID. Do not attempt to 
generate the Machine ID more than once. (Please refer to the corresponding section in 
the SmartPlant License Manager Installation and User's Guide about how to set up the 
loopback adapter.). Also, make sure the loopback adapter is the first on your network 
connection list (Control Panel > Network Connections > Advanced Settings).  

3. Select Generate Machine ID from the Intergraph SmartPlant License Manager program 
group. 

4. Send the Machine ID output to Intergraph to request a license key. If all the previous 
steps described in this section were performed correctly, SmartPlant License Manager 
should work if the laptop is connected to the network or not. No extra step is required 
when the laptop is connected back to the network.  

Q: Is there a limit for the number of seats that can be generated per key? 

A: The limit is 32766 seats per license key. 

Q: Can I run the executable of SmartPlant License Manager or SmartPlant products in XP 
compatible mode?  

A: No, you should not set SmartPlant License Manager or SmartPlant products in XP 
compatible mode. If you do, your SmartPlant products may return the following error: 

SPLM Failed [Creating/Stating] The parameter is incorrect. 
SOFTWARE\Intergraph\Pdlice_etc  

Q: When an application is on a machine that is disconnected from the network without 
exiting the product, how long is the license held? 

A: 16 hours.  

Q: Which products can have daily licenses?  

A: Currently PDS and S3D support daily licenses.  
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Q: How long would a daily license last?  

A: A daily license expires after 12 hours.  

Q: We installed a key for three licenses, but we can operate only two licenses at the same 
time. Why?  

A: There can be several reasons.  

Click Display Status of Reserved License on the Display Options dialog box to 
determine the number of licenses that your key contains. 

Click Scavenge for Keys on the Scavenge Options dialog box to scavenge for the third 
license that you are unable to use.  

Verify that clients and servers can ping to each other. Look for anomalies such as two nodes 
on the network with the same name or the reuse of an old name for a new computer, but 
with some traces of the old computer still existing in files on the network.  

Q: What is the difference between the Select License Machine for Client command and 
the Select License Machine for Client (Current User) command? 

A: The Select License Machine for Client command updates the 
HKEY_LOCAL_MACHINE (HKLM) list of license machines so that all users will have the 
same list of license servers. This command requires administrator privileges. 

The Select License Machine for Client (Current User) command updates the 
HKEY_CURRENT_USER (HKCU) list of license servers for a specific user. This command 
runs with non-administrator/standard user privileges. There can be a different list of license 
servers for each user on a machine. 

 HKCU takes precedence over HKLM. In other words, if HKCU is set, SmartPlant 
License Manager does not use the license machines in HKLM. 

Q: How does the PDLICE_WAIT variable work? 

A: For interactive jobs, the jobs do not wait for licenses if none are available. You are 
notified immediately that the jobs did not start. You can retry. 

For batch jobs, the variable PDLICE_WAIT can be used to change the wait time. By default, 
a batch job will wait for up to 12 hours for a license to become available. You can change 
the wait time by setting the environment variable on the client computer from which the 
license was attempted to be obtained. 
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S E C T I O N  5  

Uninstall instructions for CADWorx and CADWorx Design Review are as follows. 

Uninstall CADWorx 
1. Click Start > Control Panel. 

2. Under Programs, click Uninstall a program. 

3. On the Uninstall or change a program list, double-click CADWorx (version). Alternatively, 
click CADWorx (version), and then click Change. 

4. Click Modify. 

5. Select Uninstall. 

6. If you receive the User Account Control dialog box, click Yes. 

CADWorx removes. 

7. Click Finish. 

The uninstall closes. 

Uninstall in Silent Mode 
To perform a silent uninstall, you need to type the command instructions on the command line. 

Example: 

[Root Directory]\CADWorxSetup.exe /Uninstall /silent   

Ensure you are in the directory of the CADWorxSetup.exe file. 

/Uninstall 

Runs the uninstall.  

/silent 

Specifies that you are running a silent uninstall. With the silent uninstall, the uninstall dialog 
boxes do not display, and the uninstall runs in the background. 

Uninstall CADWorx Design Review 
You can access Uninstall a program through the Control Panel. 

Remove the Software Through Control Panel > Uninstall a program. 
1. Click Start > Control Panel. 

2. Under Program, click Uninstall a program. 

3. On the Uninstall or change a program list, double-click CADWorx Design Review 
(version). 

Uninstall 
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4. In the Programs and Features box, click Yes. 

 A check box can be clicked here to turn this message off.  

5. In the User Account Control, click Yes.  

6. In the Uninstall CADWorx (version) box, click Yes. 

CADWorx Design Review removes and the uninstall closes. 
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S E C T I O N  6  

Database setup is optional for CADWorx. This section is provided for those clients who choose 
to use a Database with CADWorx. 

ODBC Drivers 
All databases associated with CADWorx use ODBC (Open DataBase Connectivity). Your 
computer must have the latest version of the ODBC drivers. To determine the ODBC driver 
versions: 

1. Click Start > Control Panel > Administrative Tools. 

2. Double-click Data Sources (ODBC). 

The ODBC Data Source Administrator dialog box appears. 

3. On the About tab, view the value for Version for each ODBC core components. The 
versions installed must be 3.50 or greater.  

4. If the files on the computer are older, download and install the latest drivers from the 
Microsoft website. 

5. Install CADWorx. 

After you install the software, the CADWorx User Data Sources list appears: 

 

Database Setup 
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ODBC drivers that are configured correctly ensure that CADWorx performs correctly. The 
following figures show the ODBC driver information.  
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The Access data source is shown in the next figure. 

 
To set up an SQL Server data source name, review the instructions in the [Product 
Folder]\System\SQLServer.txt file. The following figure shows the SQL Server data source. 
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Oracle ODBC Driver Setup 
The following instructions and screen captures describe how to setup the data source name 
(DSN) for Oracle databases. 
1. Start the ODBC Administrator from the Control Panel to setup the Oracle ODBC Driver. 

Please make certain you are running the latest version of the ODBC Administrator and 
ODBC Drivers To check the version, go to the About Tab. The latest version of ODBC can 
be found on the Microsoft Web Site. 

 
2. Hit the Add button, and select Oracle ODBC Driver. The name "Oracle in 

OraDb11g_home1" may be different on your system.   
3. In the next dialog, type in the following:  

For CADWorx P&ID: 
Data Source Name: P&ID_ORACLE 
Service Name: CWORA11g 
The Data Source Name must be P&ID_ORACLE. The service name can be whatever you 
selected for the database name. 
For CADWorx Plant: 
Data Source Name: PLANT_ORACLE 
Service Name: CWORA11g 
The Data Source Name has to be PLANT_ORACLE. The service name can be whatever 
you selected for the database name. 
For CADWorx Steel: 
Data Source Name: STEEL_ORACLE 
Service Name: CWORA11g 
The Data Source Name has to be STEEL_ORACLE. The service name can be whatever 
you selected for the database name. 
For CADWorx IP: 
Data Source Name: IP_ORACLE 
Service Name: CWORA11g 
The Data Source Name has to be IP_ORACLE. The service name can be whatever you 
selected for the database name. 

4. After the DSN is created, test the DSN by pressing the "Test Connection" button. 
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Installing and Configuring Microsoft SQL Server 2012 
Because system configurations, database software, and individual company standards vary, use 
this section as a checklist instead of step-by-step instructions for Microsoft SQL Server 2012 
SP2 (64-bit) running on a Windows Server 2008 R2 operating system. Please contact Intergraph 
Customer Support for specific configuration questions. 

If you are using a Global Workshare Configuration, you need to install the Enterprise Edition of 
Microsoft SQL Server for your Host and Satellite locations. 

 There are internationalization considerations concerning the SQL Server collation 
settings you specify that relate to reference data, using SmartPlant Enterprise integrated 
systems, Global Workshare Configuration, multiple locales, backup/restore, reports, and 
upgrading to future releases. Please contact Intergraph Customer Support for specific 
configuration questions. 

Topics 
Install Microsoft SQL Server 2012 ................................................. 41 
Install any Required SQL Server 2012 Upgrades ......................... 44 
Verify Automatic Startup of Microsoft SQL Server 2012 Services 44 
Register the Microsoft SQL Server ................................................ 45 
Assign System Administrator Privileges for SQL Server 2012 ...... 45 
Create a SQL Server Database Alert ............................................ 46 
SQL Server Port Assignments ....................................................... 48 

Install Microsoft SQL Server 2012 
1. Insert your Microsoft SQL Server DVD, and start the setup program. 

2. From the Planning page, select System Configuration Checker to check for pre-requisite 
applications and identify potential installation problems. You might have to restart your 
computer if any pre-requisite applications were installed. 

 
3. Click Installation, and then select the New SQL Server stand-alone installation or add 

features to an existing installation option. 
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4. As you go through the installation process, make sure you install the Setup Support Files 
and review any Setup Support Rules that identify potential problems. 

 
5. Enter your SQL Server 2012 product key provided by Microsoft, and click Next. 

6. Accept the license terms, and click Next. 

Wait while the SQL Server Setup files are installed on the computer. 

 
7. Click Next. 

8. Select SQL Server Feature Installation, and click Next. 
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9. When you get to Feature Selection, select the features below. 

 Database Engine Services 

 SQL Server Replication (required if the SQL server instance is set up for the Global 
Workshare configuration) 

 Client Tools Connectivity 

 Management Tools - Basic 

 Management Tools - Complete 

 
10. Click Next. 

11. Verify that all the installation rules pass, and click Next. 

 
12. Define your instance name and the instance root directory. Click Next. 

13. Verify the disk space requirements, and then click Next. 

14. On the Server Configuration page, specify a domain account name with administrative 
privileges on the system to be used. Also, set Automatic as the Startup Type and 
continue. 

 
 If you are not sure, you can use NT AUTHORITY\NETWORK SERVICE or NT 

AUTHORITY\SYSTEM and change the login later on the service. 

 A domain user account offers more flexibility and is typically used because many server-
to-server activities can be performed only with a domain user account, including remote 
procedure calls, replication, and backing up network drives. 
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15. Select the Collation tab. Use locale-specific collation. These collation settings include the 
character set, sort order, and other locale-specific settings. 

 
16. Click Next. 
17. On the Database Engine Configuration page, select Windows authentication mode. 

 
18. Specify at least one SQL Server Administrator. You will need this administrator login later to 

open SQL Server Management Studio. 
19. Click Next, and complete the installation as prompted. 
If any errors occur during installation, refer to the Summary Log for more information and 
contact Intergraph Support for further assistance. 

Install any Required SQL Server 2012 Upgrades 
You might require an upgrade or service pack of Microsoft SQL Server 2012. See CADWorx 
Database Server Recommendations for version information. If you do need to upgrade, go to 
the Microsoft website and follow instructions provided in the Microsoft Download Center. 

Verify Automatic Startup of Microsoft SQL Server 
2012 Services 

1. Open Control Panel > Administrative Tools, and then double-click Services. 

2. Verify that the Status field is set to Started and the Startup Type field is set to Automatic, 
for SQL Server (MSSQLSERVER). 

 
 The MSSQL service is appended with the named instance you specified when you 

installed Microsoft SQL Server. For example, if you installed SQL Server as an instance 
named Instance1, the service displays as MSSQL$Instance1. 

3. To change the Status or Startup Type fields, right-click the service name, and select 
Properties from the shortcut menu. 

a. On the General tab, select Automatic from the Startup type list. 

b. In the Service status section, click Start. 

c. Click OK. 
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Register the Microsoft SQL Server 
You must register the database server instance in SQL Server Management Studio on the 
database server computer and on each client computer that you plan to use for: 

 Administration tasks such a Project Management and creating or upgrading databases 

 Running the Interference Checking Service 

 Verify that Authentication is set to Windows Authentication. 

1. Open Microsoft SQL Server Management Studio. 

2. Connect to your instance using the administrator login that you created during setup. 

3. Select View > Registered Servers. 

4. Under Database Engine, right-click Local Server Groups and select New Server 
Registration. 

The system displays the New Server Registration dialog box. 

5. On the General tab, enter the name of the server instance that you want to register. 

or 

Select a server from the Server name drop-down list. 

6. Click Save. 

 Before exiting Microsoft SQL Server Management Studio, perform the steps in 
Assign System Administrator Privileges for SQL Server 2008. 

Assign System Administrator Privileges for SQL 
Server 2012 

Perform the following steps on the CADWorx database server. 

1. Open Microsoft SQL Server Management Studio, and expand the listing for your 
database server in the left tree view. 

2. In the tree view, expand the listing under Security, right-click Logins, and select New 
Login. 

The Login - New dialog box displays. 

3. Type the user account to be assigned administrative privileges in the Login name text box. 
For example, type AdminUser1. 
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4. Select Server Roles under the Select a page heading to display the Server Roles list. 

5. In the Server Roles list, select the sysadmin check box. 

 
 Standard users need db_owner and public database role membership mapping to 

each one of the CADWorx databases. Administrators need only the sysadmin role. 

6. Click OK. 

Create a SQL Server Database Alert 
When the CADWorx database server is running low on disk space, the software begins to 
display error messages because data can no longer be persisted or logged. Microsoft SQL 
Server, however, does not issue any particular alerts for the workstation computers when the 
disk is full or becoming limited. 

Using the Performance Monitor, the CADWorx administrator can create a Data Collector Set 
that contains an alert to be issued when a threshold value for a System Monitor has been 
reached. In response to the alert, System Monitor can launch an application to handle the alert 
condition. 

You must perform the following procedure on the database server computer. 

1. Open Control Panel > Administrative Tools > Performance Monitor. 

2. Expand Monitoring Tools in the Performance tree view and start the Performance 
Monitor. 

3. Expand Data Collector Sets in the tree view and right-click on User Defined. 

 
4. Select New > Data Collector Set from the shortcut menu. 

5. Type the name you want to use for the data collector set, click Create manually 
(Advanced), and then click Next. 

 



 Database Setup 
 

 

CADWorx Installation Guide 47 
 

6. Select Performance Counter Alert, and click Next. 

7. Click Add to open the Add Counter dialog box. 

8. Set the database server name in the Select counters from computer field.  

9. Select the Microsoft SQL Server object in the Available counters section. 

 
10. Select a counter in the Select counters from list list, select a counter, and the click Add. 

The new counter displays in the Added counters list. 

 Use CTRL+ or SHIFT+ to select multiple objects. 

11. After all counters have been added, click OK to close the Add Counters dialog box. 

 To add local counters from a remote computer, you must have one of the following 
permissions on the computer: 

 Local administrator privilege  

 Be a member of the Performance Monitor Users local group. 

12. Under the Performance counters list, select either Above or Below for the Alert when 
value. 
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13. In the Limit box, enter a threshold value. Depending on the object you selected, the alert 
will be generated when the value for the counter is more than or less than the threshold 
value. Click Next to continue. 

14. Click Finish.  

Your new data collector set displays in the User Defined page. 

15. To configure the alerts, double-click on your data collector set name and then right-click the 
data collector. Select Properties from the shortcut menu. 

16. On the Alerts tab, you can set additional alerts and define the unit of time for the duration of 
the sample interval. 

 
17. Set options in the Alert Action and Alert Task tabs to specify the actions to occur each 

time the alert is triggered. 

18. Click OK to close the Properties dialog box and activate the alert settings. 

 For more information about using System Monitor and setting up SQL Server alerts, 
see the documentation delivered with Microsoft SQL Server and Windows Server. 

SQL Server Port Assignments 
The Microsoft SQL Server database uses the following port assignments. 

 This assignment might not be required if Microsoft SQL Server is not used as a database 
within your SmartPlant Enterprise implementation. 

Port Number TCP/UDP Communication Comments 

1433 TCP From workstation to server; from server 
to workstation 

SQL Server Instance 

1434 UDP From workstation to server; from server 
to workstation 

SQL Browser 
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A P P E N D I X  A  

Install and Configure Oracle Server Software 
During installation of the database components, setup displays various dialog boxes that prompt 
you for information. We recommend that you refer to your Oracle documentation for specific 
instructions concerning the dialog boxes and wizard pages. 

 All domain verified user names and passwords must use ASCII7/English 
characters. Oracle does not support non-ASCII / English characters in domain user names or 
passwords and will not work. This limitation applies only to Oracle, not Intergraph. 

Topics 
Oracle Server Configuration .......................................................... 49 
Install Oracle Database 11g Release 2 Server Software (11.2.0.2)
 ....................................................................................................... 50 
Delete the Default Oracle Database .............................................. 52 
Create the CADWorx Oracle 11g Database .................................. 53 
Oracle Post-Installation Requirements .......................................... 58 

Oracle Server Configuration 
1. Log in as a user with administrator access to the server. 

2. Turn off Windows Firewall. If this is not an option, please refer to the Oracle Installation 
Guide for information on the exceptions that must be put into place prior to installing Oracle 
on Windows 7. 

3. In the Folder Options of Windows Explorer, clear the Simple File Sharing option. 

a. Open Windows Explorer. 

b. Press ALT and select Tools. 

c. Select Folder Options. 

d. Select the View tab. 

e. Scroll to the bottom and clear the Use Sharing Wizard (Recommended) option. 

4. Click OK. 
 

Appendix: Install and Configure Oracle 
Software 
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Install Oracle Database 11g Release 2 Server Software 
(11.2.0.2) 

This section will guide you through the installation process for Oracle 11g R2 (11.2.0.2) server 
software with Patch 22. 

1. Open the hosts file and enter the IPv4 address and server host name. The hosts file is 
located in C:\windows\system32\drivers\etc\hosts. 

2. Add the environment variable ORACLE_HOSTNAME=<server name> in the System 
Environment Variables. 

3. Run setup.exe from the install disk or folder while logged in as a local administrator. 

4. Enter your security update information in the Configure Security Updates screen, and click 
Next. 

5. Select Skip software updates, and click Next. 

6. Select Create and configure a database in the Select Installation Option screen, and 
click Next. 

7. Select Server Class in the System Class screen, and click Next. 

8. Select Single instance database installation in the Grid Installation Options screen, and 
click Next. 

9. Select Advanced install in the Select Install Type screen, and click Next. 

10. Select the installation language in the Select Product Languages screen, and click Next. 

11. Select Enterprise Edition or Standard Edition in the Select Database Edition screen, 
and click Next. 

12. Specify the Oracle Base location for the base folder and the Software Location for the 
home folder by browsing to the location, and click Next. 
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13. Select General Purpose / Transaction Processing in the Select Configuration Type 
screen, and click Next. 

14. Specify the Global database name and Oracle Service Identifier (SID) values in the 
Specify Database Identifiers screen, and click Next. 

 
15. Select the Memory tab on the Specify Configuration Options screen, and select the 

Enable Automatic Memory Management option. The percentage of memory allowed for 
an instance of Oracle should not exceed 40%. If you have more than one Oracle instance 
on this server, the allocated memory should not exceed 40% of the system memory. 
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16. Select the Character sets tab on the Specify Configuration Options screen and select 
the Use Unicode (AL32UTF8) option.  

 
 All products in SmartPlant Enterprise that participate in integration should set their 

encodings to Use Unicode (AL32UTF8) for the Database Character Set option, and to 
AL16UTF16 - Unicode UTF-16 Universal character set for the National Character 
Set option.  

 For more information about the Character sets option, see your Oracle installation 
documentation. 

17. Select the Security tab on the Specify Configuration Options screen, and choose your 
security settings option. 

18. Select the Sample Schemas tab on the Specify Configuration Options screen, and select 
the Create database with sample schemas option. Click Next. 

19. Select the Use Database Control for database management option on the Specify 
Management Options screen. You can also enable notifications through email with this 
option. 

20. Select File System in the Specify Database Storage Options screen and specify a 
database file location. Click Next. 

21. Specify your recovery options in the Specify Recovery Options screen, and click Next. 

 Do not enable Automated backups. 

22. Specify your schema passwords in the Specify Schema Passwords screen, and click 
Next. You must choose either the Use different passwords for these accounts or Use 
the same password for all accounts option. 
The software checks that all prerequisite software is installed on the computer. 

23. Click Finish in the Summary screen. 
24. Click Close after the installation process is finished. 
See Also 
Delete the Default Oracle Database (on page 52) 
Install and Configure Oracle Server Software (on page 49) 
 

Delete the Default Oracle Database 
The default database created earlier in this workflow must now be deleted. The following steps 
will guide you through this process. 

1. From the Start menu, select All Programs > Oracle > Configuration and Migration Tools 
> Database Configuration Assistant. 

2. Click Next on the Welcome screen. 

3. Select Delete a Database, and click Next. 

4. Select the default database that was created, and click Finish. 

5. Click Yes when asked if you want to proceed. 

6. The Database Configuration Assistant asks if you want to perform another operation. 
Click No. 

 Because no databases exist yet, this is a convenient time to load Oracle patches on the 
server. Oracle patch 22 needs to be installed before creating the Oracle database. 
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Create the CADWorx Oracle 11g Database 
These steps guide you through the database creation process. You must login to the server as a 
local administrator to create the Oracle database. 

1. From the Start menu, select All Programs > Oracle > Configuration and Migration Tools 
> Database Configuration Assistant. 

2. In the Database Configuration Assistant screen, select Create a Database, and click 
Next. 

 
3. In the Database Template screen, select the Custom Database option, and click Next. 
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4. Enter the name of the new database in the Database Identification screen. Generally, the 
Global Database Name and the SID are identical. These names can be no longer than 
eight characters. 

5. In the Management Options screen, click Next without changing the default selections. 
Configure Enterprise Manager and Configure Database Control for local management 
are the default options. 

 
6. In the Database Credentials screen, select a security option and provide the appropriate 

information. Click Next. 
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7. On the Database File Locations screen, select File System and Use Common Location 
for All Database Files. Browse to the appropriate files location, and click OK. 

A subfolder is created in the folder you choose and is named with the SID you provided 
earlier in step 4. 

 
8. Click Next. 

9. If the database will not be used in a Global Workshare Configuration, select Specify Flash 
Recovery Area in the Recovery Configuration screen, and click Next. 

If the database will be used in a Global Workshare Configuration, select Enable Archiving 
and click Edit Archive Mode Parameters. Select Automatic Archiving to specify the 
location of the archive log files. 
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10. In the Database Content screen, select the Enterprise Manager Repository option and 
click Next. 

 
11. Select the Memory tab on the Initialization Parameters screen and select the Typical 

option. The percentage of memory allowed for an instance of Oracle should not exceed 
40%. If you have more than one Oracle instance on this server, the allocated memory 
should not exceed 40% of the system memory. 

 
12. On the Sizing tab, configure the Processes option based on this formula. 

Processes ≈ (Maximum Number of Users * 10) + (Number of Oracle System Processes) 

 The number of Oracle system processes can vary based on the number of 
background processes that are running. This number is a high estimate. Overestimate the 
number to ensure it will only use the number of processes that the instance needs. 
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13. Select the Character Sets tab, and select the Use Unicode (AL32UTF8) option.  

 
 All products in SmartPlant Enterprise that participate in integration should set their 

encodings to Use Unicode (AL32UTF8) for the Database Character Set option, and to 
AL16UTF16 - Unicode UTF-16 Universal character set for the National Character 
Set option. 

 For more information about the Character Set options, see your Oracle installation 
documentation. 

14. Select the Connection Mode tab, and select Dedicated Server Mode. 
15. In the Connection Mode tab, select All Initialization Parameters. 
16. Click Show Advanced Parameters. 

The parameters required by CADWorx in are listed below: 
Name Value 
db_files 1000 
distributed_lock_timeout 180 
open_cursors 3000 
os_authent_prefix "" 
processes 200 
undo_retention 3600 

17. Click Close after the changes have been made, and click Next on the Database 
Configuration dialog box. 

 The control files should be divided among multiple physical hard drives. This file is 
needed by the database to start. 

18. Verify that the path in the Tablespaces folder is correct for SYSAUX, SYSTEM, TEMP, 
UNDOTBS1, and USERS. 

 The information in the Datafiles and Redo Log Groups folders can retain the default 
settings as long as the folder path does not need updating. 

19. Create an additional Redo log file, and set the Redo log file size for each group to 512000 K. 

20. Click Next.  

 The Creation Options screen allows you to save your database configuration as a 
template file, and also allows you to generate database creation scripts. 

 Not every setting is preserved in the template file. If you re-use template files, 
check the parameters carefully to verify the settings are correct. 

21. When you have finished configuring the database, click Finish. 

 The first 15% of the creation process validates the configuration settings. After the 
first 15% of the process has successfully passed, the database creation succeeds without 
any errors.  

22. After the Database Configuration Assistant completes the database creation, click Exit. 

See Also 
Oracle Post-Installation Requirements (on page 58) 
Install and Configure Oracle Server Software (on page 49) 
Appendix: Install and Configure Oracle Software (on page 49) 
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Oracle Post-Installation Requirements 
1. Create an administrator user (local or domain). 

2. Add this administrator to the ORA_DBA group. 

 There is no need to have both Oracle Server and Oracle Client on the same 
computer. 

3. Make sure the Administrators, System, and Users Windows groups have full access to the 
SharedContent folder on the reference data computer. 

4. Make sure the Administrators and System account have full permissions to the Database 
Templates folder. 

Oracle 11g Release 2 32-bit Client Installation 
This section guides you through the installation process for Oracle 11g R2 (11.2.0.2 and 
11.2.0.4) 32-bit client. 

1. Run setup.exe from the installation disk or folder as an administrator. 

2. Select Custom in the Select Installation Type screen, and click Next. 

3. Select Skip software updates in the Download Software Updates screen, and click Next. 

4. Select the installation language in the Select Product Languages screen, and click Next. 

5. Specify the Oracle Base location for the base folder and the Software Location for the 
home folder by browsing to the location, and click Next. 
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6. Select the product components to install in the Available Product Components screen, 
and click Next. 

 
7. Wait while the software performs the prerequisite checks, and click Next. 

8. Click Install in the Summary screen and wait while Oracle client installs. 

The Oracle Net Configuration Assistant displays. 

9. Select Perform typical configuration in the Welcome screen, click Next. 
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10. In the Welcome to the Oracle Net Configuration Assistant screen, click Next. 

 
11. Click Finish. 

12. Click Close after the installation process is finished. 

 In MSDTC, the session timeout is implemented by the registry setting 
ORAMTS_SESS_TXNTIMETOLIVE. The general rule for setting timeouts are: 

MSDTC timeout (default 60) (IIS Setting) < ORAMTS_SESS_TXNTIMETOLIVE 
(set to 120) < distributed_lock_timeout (set to 180) 

Use regedit to verify the setting as shown: 

 

  
 For Oracle 11.2.0.2 32-bit client you must install Patch 22 now. Stop the service 

OracleMTSRecoveryService if it exists and disable the service 
DistributedTransactionCoordinator BEFORE you install Patch 22. 

 For Oracle 11.2.0.4 32-bit client there is no patch installation requirement. 

See Also 
Delete the Default Oracle Database (on page 52) 
Install and Configure Oracle Server Software (on page 49) 
 



 

 

CADWorx Installation Guide 61 
 

A 
Appendix 

Install and Configure Oracle Software • 
55 

Assign System Administrator Privileges for 
SQL Server 2012 • 50 

C 
CADWorx Design Installation • 24 
CADWorx Installation • 16 
CADWorx Software Recommendations • 14 
Conventions • 7 
Create a SQL Server Database Alert • 51 
Create the CADWorx Oracle 11g Database 

• 60 

D 
Database Setup • 41 
Delete the Default Oracle Database • 60 

E 
ESL Installation • 26 

F 
Frequently Asked Questions (FAQ) • 30 

G 
General Topics FAQ • 31 

I 
Install a local lock • 26 
Install a network lock • 26 
Install and Configure Oracle Server 

Software • 55 
Install any Required SQL Server 2012 

Upgrades • 49 
Install in Silent Mode • 19 
Install Microsoft SQL Server 2012 • 46 
Install Oracle Database 11g Release 2 

Server Software (11.2.0.2) • 56 
Installation • 16 
Installing and Configuring Microsoft SQL 

Server 2012 • 45 

L 
Licensing • 25 

N 
NetHASP License Manager / NETHASP.INI 

Instructions • 27 
Notes on Network ESLs • 27 

O 
ODBC Drivers • 41 
Oracle 11g Release 2 32-bit Client 

Installation • 66 
Oracle ODBC Driver Setup • 44 
Oracle Post-Installation Requirements • 66 
Oracle Server Configuration • 55 

P 
Preface for CADWorx Installation Guide • 6 
Purchasing Licenses FAQ • 30 

Q 
Quick Installation Workflow • 29 
Quick Start • 16 

R 
Register the Microsoft SQL Server • 50 
Repair in Silent Mode • 21 
Requirements for fieldPipe • 15 

S 
Setup Profile • 22 
SmartPlant License Manager Installation • 

29 
Software Installation on Network Drive • 23 
SQL Server Port Assignments • 54 

T 
Technical Support • 8 
Troubleshooting Network Locks • 29 

U 
Uninstall • 39 

Index 



 Index 
 

 

CADWorx Installation Guide 62 
 

Uninstall CADWorx • 39 
Uninstall CADWorx Design • 40 
Uninstall in Silent Mode • 39 

V 
Verify Automatic Startup of Microsoft SQL 

Server 2012 Services • 49 

W 
Welcome to CADWorx • 13 
What's New in CADWorx Installation • 12 
 


	Preface for CADWorx Installation Guide
	Conventions
	Technical Support
	What's New in CADWorx Installation

	Welcome to CADWorx
	CADWorx Software Recommendations
	Requirements for fieldPipe

	Installation
	Quick Start
	CADWorx Installation
	Install in Silent Mode
	Repair in Silent Mode
	Setup Profile

	Software Installation on Network Drive
	CADWorx Design Review Installation

	Licensing
	ESL Installation
	Install a local lock
	Install a network lock
	Notes on Network ESLs
	NetHASP License Manager / NETHASP.INI Instructions
	Troubleshooting Network Locks


	SmartPlant License Manager Installation
	Quick Installation Workflow
	Frequently Asked Questions (FAQ)
	Purchasing Licenses FAQ
	General Topics FAQ



	Uninstall
	Uninstall CADWorx
	Uninstall in Silent Mode

	Uninstall CADWorx Design Review

	Database Setup
	ODBC Drivers
	Oracle ODBC Driver Setup

	Installing and Configuring Microsoft SQL Server 2012
	Install Microsoft SQL Server 2012
	Install any Required SQL Server 2012 Upgrades
	Verify Automatic Startup of Microsoft SQL Server 2012 Services
	Register the Microsoft SQL Server
	Assign System Administrator Privileges for SQL Server 2012
	Create a SQL Server Database Alert
	SQL Server Port Assignments

	Appendix: Install and Configure Oracle Software
	Install and Configure Oracle Server Software
	Oracle Server Configuration
	Install Oracle Database 11g Release 2 Server Software (11.2.0.2)
	Delete the Default Oracle Database
	Create the CADWorx Oracle 11g Database
	Oracle Post-Installation Requirements

	Oracle 11g Release 2 32-bit Client Installation

	Index



